PRESIDENT’S MESSAGE
Welcome to spring!
If you attended the January and February CLE Luncheon and General Membership Meeting, you probably
noticed that those meetings were presided over by your Board Members, Ariane Walton, Sherry Stowers, and
Amber Haney, with support from Jennifer Rogers, and Committee Chairs Francesca Romans and Carli Collins.
True to the wild world of litigation, I lived in Houston for the month of January for an extended trial and was in
trial yet again in February and was unable to preside over these luncheons. Why do I mention this? I want the
membership to know how hard the leadership works toward keeping the organization moving forward and how
appreciative I am that I can rely on these leaders to share the load when needed.
Nothing is too heavy when everyone carries ~
Sometimes, life and work demands your attention and your perfectly planned routine is shaken. It’s comforting to know that
CAPA has a strong leadership to help carry the load. CAPA’s leadership of the Board and Committee Chairs is made up of
volunteer members, and while we are pressing forward and growing the organization, with growth comes the necessity for
more hands to carry the load.
CAPA’s committees develop activities and programs that the membership relies on. As just one example, when you attend a
monthly CLE luncheon, did you know there are 6 committees that are involved in putting together that one-hour activity?
Before the CLE, our Programs Committee works year-round in soliciting and scheduling speakers, reviewing member surveys
of suggestions, and obtaining CLE credit from NALA and TBLS. The Programs Committee then works with the Web Team
Committee to post the CLE luncheon on our calendar and notify you of open registration with reminder emails so you don’t
miss it. The RSVP Committee reviews the registration list, makes name tags for the luncheon, handles checking in attendees,
collecting registration fees, obtains door prizes to give away, and works with the venue on planning. The Public Relations
Committee makes sure that we have Board members present to greet you and schedule committee chairs to speak at the
luncheon about their committee. The Sustaining Member Liaison coordinates with and schedules our Sustaining Members to
attend the luncheon to share their support. The Community Services Committee handles collection for our Flower Fund charity
and works with the Treasurer to record any donations. This is just one small example!
It’s easy to attend a CAPA event or participate in an activity without thinking about how we got there – before joining the
leadership, I know I didn’t realize it either. Even with all of the work behind the scenes, we have an amazing group of
volunteers that band together to provide a valuable activity or resource for the membership,
and they need your help, so this is my call to action to the membership. If you have an extra
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couple of hours a month in your free time and would like to lend a helping hand to continue
these activities, please let us know! We literally cannot do this without you. There are MANY
• March event calendar
opportunities to volunteer – no matter how much or how little time you have to give – it’s all
helpful and greatly appreciated. Reach out to me or the Board if you’d like to find an area
• 5 Ways to Connect with
where you can share your talents!
CAPA | 5 Ways to Get
Cheers ~
Brittany Posadas, TBLS-BCP
CAPA President 2019-2020
president@capatx.org

Involved

• Spring Pro Bono Events
• Keep Austin Beautiful Day—
April 18. Save the Date!
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BOARD SPOTLIGHT
PARLIAMENTARIAN/HISTORIAN, Sherry Stowers
One of the challenges all us, as paralegals face, is having the time to invest in a
professional association such as CAPA. Our time is not viewed the same way as
attorney time. Most of us work hourly and are held to a strict 8-hour day were we
must meet billing expectations within that time frame. Attorneys, on the other
hand, are salaried which allows for more flexibility. Also, some of our firms are not
are supportive as others. I say all of this to say, as a board member of CAPA, I am
extremely appreciative all of the paralegals who make such amazing sacrifices to
carry on the day-to-day activities that the association demands. The CLE events,
the monthly luncheons, lunch-and-learn events, The Brief, Membership, web team and other
services provided by CAPA – none of this gets done without hard work and sacrifice on the part of
those who are serving in these capacities as chairs and committee members. I appreciate myself
for the sacrifices that I make – I have more senior moments that I want to admit (LOL).
So, if you think you don’t have time to serve, you’re right – you don’t. It’s a sacrifice period. And I
hope you will consider making such sacrifice for an association that is well worth the effort.
I am Sherry Stowers, CAPA’s Parliamentarian.

COMMITTEE SPOTLIGHT
COMMUNITY SERVICE

Keep Austin Beautiful Day - Saturday, April 18
CAPA members and their friends and family will gather to clean up our sponsored
portion of South Congress. See the event page for details.
As always, email community@capatx.org for community service-related
questions, ideas, or feedback!
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UPCOMING EVENTS

Pennie Blake

(Click the links for details/registration)

Elizabeth Bruton

TBLS 2020 Induction Ceremony

Mar 07

Pro Bono Opportunity: Volunteer
Notaries needed March 7

Mar 12

Mar 25

CAPA and Paralegal Division
District 4 Lunch & Learn CLE
Event: "Using Technology From
Collection Through Review"
March Membership Meeting &
CLE Luncheon: Advancement in
Vehicle Safety Data (Title TBA)

Apr 08

April Board Meeting

Apr 18

Keep Austin Beautiful Day 2020!

Joni Bures Gruver

March birthdays

Mar 06

Elizabeth Canfield
Mary Cloer
Emily Gatlin
Angela Aldrich Goldberg

Emma Herrera
Ruth Konderla
Amanda Lequerique
Brittany Posadas
Megan Schreven
Nelly Soriano
Lori Thieme
Ariane Walton

Did we miss your birthday? Log in and update your member
profile, or let us know.

ANNOUNCEMENTS & NEWS
Thanks to all those that attended the Full-Day CLE on
February 14. This event was made possible by CAPA and our
generous event sponsors:

GRAND PRIZE SPONSOR
Team Legal

LUNCH SPONSOR
Loewy Law Firm

MORNING BREAK SPONSORS
Park IP
Pro-Lit

AFTERNOON BREAK SPONSOR
iNSERVIO3
The Legal Connection

TABLE SPONSORS

MARCH MEMBERSHIP
MEETING & CLE LUNCHEON

Kim Tindall & Associates
Lexitas
Veritext Legal Solutions

EARLY
REGISTRATION
MEMBERS - $27
NON-MEMBERS - $30

LATE REGISTRATION
(AFTER 3/20) - $35

CLICK HERE TO
REGISTER ONLINE

ANNOUNCEMENTS & NEWS

ANNOUNCEMENTS & NEWS

MARCH SPOTLIGHT SUSTAINING MEMBER(S)

ARTICLE

S

tyles in Microsoft Word are pre-set formats you can
apply to parts of your document. There are existing
Styles for body text (Normal) headings (Heading 1,
Heading 2, etc.), and you can create other types for block
quotations, bullet lists, and more. Styles allow you to set
font, line spacing, paragraph spacing, automatic tabbing,
and other features and then apply those pre-set formats to
any document. On a PC, you can find Styles in a large
section at the Home tab. (It’ll be different on a Mac.)
If you spend a lot of time creating Word documents, I
encourage you to learn more about Styles. Yes, there’s a
learning curve, but you’ll save time and reduce frustration if
you master Styles. One good source to consult is this book:
Ben M. Schorr, The Lawyer’s Guide to Microsoft Word
(2015)

GETTING STARTED
You’ll need to change Word’s default Styles. For example,
the default Normal Style (for body text) uses Calibri, a sans
serif font that’s probably not right for most legal documents.
Some of the default Heading Styles use colored fonts—also
not right for legal writing. So right click on the Style you
want to change, choose “Modify,” and set it up the way you
want: choose a font, click Format then Paragraph and set
the line spacing (double, single), and then set the
paragraph spacing (probably zero). Tell it to automatically
indent one tab for each new paragraph. Or don’t; you can
still do it manually. For the Heading Styles, do the same but
apply boldface or italics. To keep these new Styles, click
the button for “New documents based on this template.”
Once you’ve made your Style choices, create your
document by typing and, as you go or during revision,
apply your Styles. To apply a Style to any piece of text,
select the text, or place your cursor in the text, and choose
the appropriate Style.
THREE REASONS TO USE STYLES
First, you’ll get consistent formatting. All your headings at
the same level will look the same, all your lists will look the
same, all your block quotations will look the same, and so

on. Naturally, you’re
aiming for consistency
already, but Styles
make
consistency
easier. For a block
quotation, instead of indenting left and right and converting
to single spacing, just type (or paste in) the text and click
the Style for Block Quotation. Done.
Universal changes are easy, too. To change all your firstlevel headings from bold italics to bold, you don’t find and
re-format each one. Instead, modify the Heading 1 Style
from bold italics to bold, and the format changes
automatically.
Second, with Styles for headings, you can use the
Navigation Pane. To see it, go to the View tab. In the Show
section, check the box for Navigation Pane. It appears on
the left and displays an outline, pulling the entries from your
Styles Headings. The entries in the outline are click-able,
allowing you to move around easily in a large document—
like a 40-page brief or a 60-page contract.
Third, using Styles enables you to create a Table of
Contents in seconds. Go to the References tab, click on
Table of Contents, and choose Custom Table of Contents
(near the bottom). Word will generate a table of contents
from the Styles headings in your document—correct page
numbers and all. You can adjust the settings: How many
heading levels do you want displayed? Do you want the
entries to be hyperlinked? And so on. If you make any
changes later, right click on the table of contents and
Update Field to update the headings and the page
numbers.
I’ll admit it took me a while to master the Styles function
and to see the benefits, but ultimately it was worth it. I now
save time when I create and modify documents, and
producing a table of contents in 10 seconds is wonderful.
So it might take a while to master the Styles function, but
the effort will pay off in time and headaches saved. 

Fun Fact
South By Southwest is the highest
revenue-producing event outside of
athletic and other events associated
with The University of Texas at Austin for the Austin
economy, with an estimated economic impact of
$190.3 million in 2012, increasing to $218 million in
2013, $315 million in 2014, $317 million in 2015, and
$325 million in 2016. The economic impact on the
Austin economy from SXSW in 2018 was $350.6
million. In comparison, Super Bowl LI brought a
$347 million economic impact to the Houston
economy in 2017, and the 2017 Final Four brought a
$324 million economic impact to the economy of
Phoenix, Arizona.

The perfect gift for your
paralegal BFF

Paralegal Life: A Snarky Coloring
Book for Adults
“With each page you color, feel the
exhaustion and stress melt away like so
many ocean waves and margaritas.”

Did you know about these weird laws?
In the State of Texas...
• Be courteous about your neighbor’s garbage. The next time you want to eat
your neighbor’s garbage, be sure to get their permission first. If you don’t, you
could serve jail time.
• It’s illegal to milk another person’s cow in Texas.
• In Texas, it is considered illegal to drive without windshield wipers. But you
don’t necessarily need a windshield.

THANK YOU FOR BEING A MEMBER OF
CAPITAL AREA PARALEGAL ASSOCIATION
an affiliate of

Not a member? Visit the membership page to apply
online.

CONNECT WITH CAPA ON SOCIAL MEDIA

The Brief is published monthly, in Austin, Texas.
For publication inquiries, email the Publications Chair at
publications@capatx.org. The Brief is designed to provide a
forum for reporting news and/or opinions of interest to
CAPA members and other subscribers.
The opinions
expressed herein are solely those of the writer and not the
Board or CAPA.
Publication herein does not imply
endorsement in any manner. No information contained
herein is intended nor should it be construed as legal
advice. Inclusion and editing of material is at the sole
discretion of the editor.
You received this email as a privilege of your membership in
Capital Area Paralegal Association and opted in at
http://www.capatx.org/
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